
 

 

 

 

MEMÒRIA 

SIG I ARQUEOLOGIA 

EL RIU LLOBREGAT I LA SEVA RELACIÓ AMB EL 
TERRITORI A L’ÈPOCA ROMANA 

 

 

 

 

 

 
 
 
 
ALUMNE: Toni Laut Barberán 
Dirigit per Anna Muñoz 
 

Projecte Final de Carrera 
Enginyeria Informàtica 
Curs 2007-2008, segon semestre 
Juny de 2008 



 
 
 
 
Dedicat a la meva Família 
Agraïments a Anna per la seva ajuda i ànims 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



El riu Llobregat i la seva relació amb el territori a l’època romana 

 Antoni Laut Barberán                                                                                                                                                                                       
                                                                                                                                                                                                       
                                                                                                                                                                                                        1 

 
Resum del Treball de Final de Carrera 
 
Sistemes d’Informació Geogràfica i Arqueologia. 
El riu Llobregat i la seva relació amb el territori a l’època romana. 
 
 
Amb el Treball El riu Llobregat i la seva relació amb el territori a l’època romana es culminen els 

estudis de l’Enginyeria Tècnica Informàtica aplicant al llarg del seu període de realització els 

coneixements adquirits durant el transcurs de la carrera. 

L’objectiu del Treball és establir una relació entre l’antic traçat del riu Llobregat al seu pas per diverses 

poblacions de Catalunya enclavades a la Comarca del Baix Llobregat i els jaciments arqueològics 

datats a l’època romana amb la perspectiva de la utilització de la via fluvial com element de transport. 

Per l’anàlisi de les ubicacions de les diferents entitats geogràfiques s’utilitza una eina de programari 

específica: Sistema d’Informació Geogràfica (SIG) amb la qual es construirà el nostre sistema de 

referència per extreure les conclusions oportunes. 

A la primera part del treball es fa una introducció general delimitant els objectius i s’estableix un Pla de 

Treball. A continuació es fa una descripció dels principals conceptes topogràfics i de cartografia 

necessaris per desenvolupar l’estudi i una explicació sobre el funcionament de l’eina específica 

d’Informació Geogràfica: Intergraph ® Geomedia® Professional 6.0 i els seus mòduls addicionals Grid i 

Terrain. 

A la segona part es fa una aplicació del programari, utilitzant les eines que ens proporciona el SIG, per 

tal d’obtenir ubicacions georeferenciades i analitzar les possibles relacions entre el jaciments romans de 

l’antiga llera del Llobregat i el traçat del mateix riu. 

L’ús de la Informàtica i en concret, d’un Sistema d’Informació Geogràfica per l’estudi d’aspectes 

concrets de diferents disciplines és un clar exemple de la utilitat creixent d’aquestes eines que van 

ampliant de forma progressiva el seu àmbit d’aplicació a totes les ciències. 

Tanmateix, com a futurs Enginyers Informàtics, hem de disposar de coneixements adquirits suficients 

per l’aplicació correcta de qualsevol programari a l’estudi d’un fet concret, en aquest cas ajuda a 

l’arqueologia pel seu anàlisi històric. 
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1.Memòria 
 

1.1 Introducció 

Com a culminació dels coneixements adquirits durant l’estudi de la carrera d’Enginyeria Tècnica 

Informàtica descrivim el present treball on desenvoluparem les funcionalitats d’un Sistema 

d’Informació Geogràfica que ens ajudarà a analitzar diferents qüestions relacionades amb restes 

arqueològics localitzats al Baix Llobregat. 

 
1.1.1 Justificació del TFC 

Una de les rutes de transport existents a l’època romana a la zona de Barcelona comunicava la mateixa 

ciutat amb la Via Augusta, a prop de Martorell, aprofitant la navegabilitat del riu Llobregat entre 

aquests dos punts. 

L’intercanvi entre aquests punts d’origen i destinació de mercaderies originava una forta interrelació 

amb el territori mitjançant els assentaments humans propers a la via navegable. 

Amb el present Treball s’analitzaran els jaciments adjacents al curs del flumen Rubricatum, les seves 

relacions fruit del trànsit comercial, les raons de les seves ubicacions i la seva activitat influenciada per 

la proximitat al riu.  

Per la realització de les tasques d’anàlisi es construirà un Sistema d’Informació Geogràfica (SIG), 

utilitzant Intergraph ® Geomedia® Professional 6.0 que permetrà situar l’antic traçat del curs del 

Llobregat i incorporar dades de referència actuals com mapes topogràfics, ortofotomapes i un Model 

Digital del Terreny. 

La incorporació d’aquests paràmetres permetrà realitzar consultes per determinar la interrelació entre 

els jaciments i les funcions que desenvolupaven en relació a l’activitat comercial i logística de l’època. 

 
1.1.2 Objectius del Treball de Final de Carrera 

 
1.1.2.1. Objectius generals 

Les fites principals a assolir amb el  treball de final de carrera estaran en consonància amb els objectius 

concrets del Pla Docent: 

� Conèixer les característiques d’un SIG. 

� Saber plantejar un Projecte SIG. 

� Saber utilitzar les eines que ens proporciona el SIG per resoldre un problema concret. 
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� Aprendre a realitzar una aplicació SIG sobre un programa d’ús general. 

Tanmateix, a la finalització del projecte haurem de ser capaços de: 

� Conèixer i utilitzar adequadament, en relació a la qüestió proposada, el programari de 

Intergraph ® Geomedia® Professional 6.0 . 

� Construir i relacionar una Base de Dades amb els elements proporcionats per l’anàlisi. 

� Fer una adequada tasca de recerca per obtenir dades geogràfiques i comprendre els principals 

conceptes de topografia i cartografia necessaris per obtenir i manipular dades amb el 

programari d’Informació Geogràfica. 

� Comprendre els conceptes de la tecnologia SIG i la seva metodologia 

� Trobar, generar i manipular dades geogràfiques. 

� Demostrar coneixement pràctic de les operacions d’anàlisi espacial i transformacions en el SIG 

analitzat. 

� Demostrar coneixement pràctic d’operacions d’anàlisi raster. 

� Entendre i saber usar les operacions de visualització i anàlisi de MDT (models digitals del 

terreny). 

1.1.2.2. Objectius específics 

� Digitalitzar el traçat del riu Llobregat segons les fonts històriques i realitzar vistes en 3D sobre 

el MDT de la zona aportant el màxim d’informació històrica complementària. 

� Analitzar la relació del llit del riu amb la ubicació dels jaciments arqueològics i les vies de   

transport. 

1.1.3 Enfocament i Mètode emprat 

El treball s’enfoca des de dos punts de vista: La primera part teòrica on s’estudien i defineixen els 

principals aspectes de la topografia i cartografia imprescindibles per la realització del treball. La segona 

part pràctica on s’especifica el funcionament del programari de Geomedia com a eina d’informació 

geogràfica. En aquesta mateixa part apliquem el SIG a l’estudi de les relacions entre els jaciments 

arqueològics de l’època romana a diverses poblacions del Baix Llobregat i l’antiga conca del mateix 

riu. 
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1.1.4 Planificació del Projecte 

 
Les principals fites del Projecte es resumeixen a la següent taula: 
 

Ordre de la 
Tasca 

Contingut del lliurament Lliurament 

1 
Pla de treball: Objectius, Temporització, Fites, Diagrama de Gantt, Definició 
PAC's, Material i programari necessari, nombre de planes, incidències i riscos. 11 de Març de 

2008 

2 

Part teòrica: Introducció als SIG, Introducció a la cartografia, Descripció 
Geomedia Professional 6.0.                                                                             

Part pràctica: Inventari de jaciments, Incorporació dels símbols per la 
representació dels jaciments. Digitalització del traçat del riu a l’època romana. 
Definició de toponímia antiga. Incorporació de dades de referència actuals, 

mapes topogràfics, ortofotomapes i un Model Digital del Terreny. 

15 d’Abril de 
2008 

3 

Part pràctica: . Incorporació de dades de referència actuals, mapes topogràfics, 
ortofotomapes i un Model Digital del Terreny. Generació de vistes interactives 

3D del riu, corbes de nivell i toponímia. Generació de perfils del terreny 
corresponents a la zona d’estudi.  

20 de Maig de 
2008 

4 

 

Realització de consultes i establiment de conclusions. Presentació del TFC 
(Memòria i Presentació Virtual) 

9 de Juny de 
2008 

 

5 
Realització del debat virtual 23-27 de Juny 

2008 
Taula 1 fites del Projecte 

 

1.1.5 Productes Obtinguts 

El principal producte obtingut després de realitzar el present treball és la memòria, el projecte gsw, una 

presentació  en PowerPoint descriptiva del Projecte i la base de dades dels arxius de jaciments.. 

 

1.1.6 Descripció dels capítols de la memòria 

 
La primera part de la memòria fa la part introductòria del treball definint la justificació, els objectius, el 

mètode emprat, la planificació del projecte i els productes obtinguts després de la realització de la 

mateixa. 

La segona part dóna idea de quina són les funcionalitats i components d’un sistema d’informació 

geogràfica. En aquest capítol es fa una diferenciació entre els tipus de codificació de dades que admet 

un SIG, s’introdueix el concepte de la interoperabilitat i es comparen les principals característiques dels 

sistemes SIG, CAD i els SGBD. Per últim s’analitzen quines són les principals aplicacions d’aquests 

sistemes. 
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La tercera part descriu els principals elements de cartografia necessaris per entendre el funcionament 

d’un SIG. Introduïm els conceptes de Geoide i el·lipsoide de referència, Datum, coordenades 

geogràfiques, escala cartogràfica, projeccions i coordenades UTM. També es fa una referència a la 

tasca de l’Institut Cartogràfic de Catalunya. 

La Quarta part explica quines són les principals funcionalitats del programari utilitzat per la realització 

del treball. És fa una introducció a les principals opcions de funcionament de Geomedia 6.0 

especificant els principals entorns com l’espai de treball, els magatzems de dades, les connexions, les 

entitats, les consultes i els principals formats de dades que utilitza el programa. També es fa una petita 

introducció als mòduls Grid i Terrain accessoris al programa Geomedia i que s’utilitzaran per l’anàlisi 

raster i per les vistes en 3D del terreny estudiat.  

 

1.2 Generalitats dels Sistemes d’informació geogràfica 

 
L’objectiu d’aquest apartat és realitzar una introducció al concepte de Sistema d’informació geogràfica 

definint i explicant les seves  principals característiques...  

1.2.1 Antecedents, definició i concepte 

 

Al voltant de l’inici de la dècada dels anys 60 van sorgir les primeres iniciatives amb els projectes 

LUNR (Land Use and Resource Information System) i el PIOS (Polygon Information Overlay 

System)[1], que es centraven més aviat en la generació automàtica de mapes de gran qualitat i la 

cartografia. Cap a els anys 80 es van impulsar eines de tipus CAD (Computer Aided Design)[2] on, amb 

l’ajuda d’ordinadors més potents es va començar a desenvolupar un cert anàlisi de la informació 

espacial. En la dècada dels 90 es va generalitzar la utilització d’aquests sistemes ampliant el seu abast a 

nombrosos àmbits d’estudi de diferents disciplines científiques. 

Un Sistema d’Informació Geogràfica (SIG) és una aplicació informàtica que utilitza informació 

d’ubicació de diferents entitats representades en un mapa mitjançant sistemes de coordenades de forma 

que ens facilita l’anàlisi a la recerca de patrons que ens ajudin a la presa de decisions. Un SIG pot 

representar en un mapa qualsevol informació extreta d’una base de dades donant una perspectiva 

dinàmica d’una determinada situació seleccionant elements amb diferents criteris que ens interessin per 

analitzar un model de comportament[3]. 

 

1.2.2 Funcionalitats d’un SIG 

En un SIG podem distingir dos grans grups de funcionalitats un referent a l’entrada i manipulació de 

dades i un altre referent al seu anàlisi: 
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Entrada de dades: permet el tractament d’arxius amb components geogràfics, la importació de dades i la 

seva manipulació en alguns casos, la seva visualització i gestió, la representació d’atributs de tipus 

cartogràfic i la recuperació i tractament de la informació. 

Anàlisi de dades: permet respondre a qüestions relacionades amb: 

� Localització d’entitats i punts geogràfics. 

� Establiment d’àrees subjectes a unes determinades condicions. 

� Evolució d’unes determinades sèries de dades. 

� Delimitació de rutes òptimes. 

� Pautes comuns en l’anàlisi d’esdeveniments. 

� Hipòtesis en base a determinats models de comportament. 

Els SIG permeten establir comparacions entre escales i perspectives simulant representacions de 

diferents llocs al mateix temps. Tanmateix permet diferenciar entre canvis qualitatius i quantitatius, 

gestionant un gran volum d’informació que poden estar en diferents formats atès a la seva diversa 

procedència, en diferents escales i projeccions mitjançant la superposició de capes. Aquestes 

característiques fan que siguin aplicables a una gran varietat d’aplicacions i desenvolupaments servint 

de base per a la presa de decisions estratègiques. 

El SIG funciona com una base de dades amb algun atribut que disposi d’una component geogràfica 

associada per un identificador comú en tots els registres als objectes gràfics d’un mapa digital. Amb 

aquesta característica ubiquem l’entitat representada per uns registres concrets de la base dades en una 

realitat geogràfica concreta (mapa) de forma que, no només disposem de la seva situació sinó de tots els 

seus atributs i informació associada. El SIG separa les dades homogènies en diferents capes temàtiques 

i les emmagatzema de forma independent. Amb aquesta característica assolim diferents perspectives 

d’una realitat quan anem incorporant successivament diferents sèries d’informació totes referides al 

mateix àmbit geogràfic. 

 

Fig.1 Capes d’un SIG [4]  
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1.2.3 Components d’un SIG  

Es pot considerar que un SIG disposa dels següents elements: Maquinari, Programari, Informació i 

Organització personal.[5] 

Maquinari: tots els components de hardware necessaris per desenvolupar el sistema. Es disposa de 

Perifèrics d’entrada com el teclat o el ratolí, de sortida com impressores o els arxius generats i 

d’emmagatzematge com el disc dur. El nivell de complexitat del maquinari vindrà determinat pels 

objectius d’anàlisi del problema. En el present treball el maquinari utilitzat es limita a un ordinador 

convencional amb capacitat suficient per treballar amb el volum de dades proporcionat. 

Programari: Eina informàtica comercial que ha de disposar de les funcionalitats mínimes com: 

Entrada, gestió, Manipulació, anàlisi i representació de dades. 

Informació: Segons el Professor Jordi Martín [5] la informació és el pilar sobre el qual es sustenta 

qualsevol SIG i representa el 70% de l’esforç final en la construcció d’un SIG específic. La recopilació 

sistematitzada de les dades i la referència a punts geogràfics amb dades de la seva localització és 

imprescindible per l’anàlisi. 

Organització personal: Un SIG necessita estar integrat dintre d’una organització que és la que realitza 

la incorporació de les dades i el manteniment continuat de l’aplicació. Sense els recursos humans 

d’aquesta organització no hi hauria eficiència en la gestió del sistema. 

1.2.4 Topologia 

És la part de la matemàtica que estudia aquelles propietats dels conjunts de punts de la recta, del pla i 

de l’espai que no són alterades per les transformacions contínues. Són propietats geomètriques que no 

depenen de cap magnitud sinó de la posició relativa dels punts[5]. La informació topològica busca 

models representatius de la realitat en forma simplificada per poder tractar de forma matemàtica la seva 

geometria. 

El SIG utilitza aquests models simplificats de la realitat per a la representació de les dades. Els dos 

models bàsics de representació són el model vectorial i el model raster. 

1.2.4.1 Model Vectorial 

Aquest model utilitza vectors definits per parells de coordenades relacionades amb algun sistema 

cartogràfic per descriure objectes de la realitat. 

En el sistema vectorial definim els següents elements geomètrics: 

Punt: Objecte espacial de dimensió 0. Representa interseccions, localitzacions concretes d’elements,  

canvis de traçat i qualsevol entitat que, considerada geogràficament, es pugui representar  

Línia: Objecte de dimensió 1 definit per la unió de dos punts. 
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Polígon: Objectes de dues dimensions definits per 

una successió de línies que delimiten una 

superfície. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

El model vectorial utilitza principalment tres formes d’emmagatzemament de les dades:  

1. Llista de coordenades 

 

 

 

 

 

 

 

 

 

 
Fig.3 Llista de coordenades [7] 

 
L’estructura de les dades al sistema vectorial consisteix en definir un objecte espacial amb un 

identificador i una llista de coordenades dels  vèrtex que defineixen la seva posició a l’espai. Un mapa 

estaria representat per un arxiu de dades, que guarda un identificador i les coordenades (x,y) dels 

elements. 

 

Fig.2: Model Vectorial[6] 
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2. Diccionari de vèrtexs 

 

 Fig.4 Diccionari de vèrtexs [7] 
 

El sistema emmagatzema dos fitxers, un amb les coordenades dels punts representatius i altre amb la 

informació dels elements geomètrics a representar. 

3. Arc-Node 

 

Fig. 5 –Arc-Node [7] 

El sistema emmagatzema quatre fitxers: 

Fitxer 1:Coordenades dels nodes i vèrtexs de cada arc: 

ARC Node origen Vèrtexs intermedis Node final 

1 3.2, 5.2 1, 5.2 1.3 

2 1.3 1.8, 2.6, 2.8, 3.3, 3.4 3.2 5.2 

3 1.2 3.5, 2 4.2,2.7 5.2 2.7 
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Fitxer 2: Topologia dels Arcs 

ARC Node origen Node final Polígon dreta Polígon esquerra 

1 1 2 Extern A 

2 2 1 A Extern Extern 

3 3 4 Extern  

 

Fitxer 3: Topologia de polígons 

Polígon Arcs 

A 1,2 

 

Fitxer 4: Topologia dels nodes 
 

Node Arcs 
1 1,2 
2 1,2 
3 3 
4 4 
5 5 

Taula 2 Definició coordenades Arc-node 
 
Aquesta metodologia, sens dubte molt robusta, basa la seva estructuració en un primer fitxer de 

recopilació de definició del elements geomètrics i tres fitxers més de definició d’arcs, polígons i nodes. 

1.2.4.2 Model Raster 

 
En el model raster es defineixen les cel·les de 

memòria (píxels) pel seu contingut i no pels seus 

límits com fa el model vectorial. L’agrupació de la 

informació representada en aquestes cel·les s’agrupa 

per definir models de la realitat amb una certa 

perspectiva de tridimensionalitat al disposar 

d’informació adicional a la de la relació cartesiana 

bidimensional més limitada que dóna el model 

vectorial. La relació de píxels es guarda en una 

estructura de dades tipus llista amb la coordenada 

del píxel i informació del seu contingut fent 

referència a una base de dades d’aspectes visuals 

(colors, textures i relleus). Lògicament l’exactitud de 

la representació gràfica estarà en funció del nombre 

de píxels necessaris. Si la cel·la representa zones 

Fig.6 Model Raster[6] 
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molt petites la resolució de l’objecte serà més gran però també utilitzarà més volum de memòria. 

Disposem de dos tipus de codificació de la informació en el model raster: 

1. Enumeració exhaustiva: 

Es registra individualment el valor de cada píxel i no hi ha cap compressió encara que un mateix 

valor es repeteixi moltes vegades. 

2.   Run Length Encoding 

Codificació raster consistent en agrupar grups de cel·les de longitud variable però d’igual contingut 

amb l’objectiu de l’estalvi de memòria.          

 

 
Fig.7 Models de codificació de dades raster [8] 

 

1.2.4.3 Avantatges i desavantatges dels diferents models de codificació 

 
Encara que el model de codificació de les dades dependrà dels tipus d’entitats a representar, actualment 

els SIG suporten tots dos tipus de codificació. En general podem definir avantatges e inconvenients dels 

dos models: 

Model Vectorial 

� Més apte per representació de dades geogràfiques amb límits ben definits com límits 

geogràfics, carreteres, rius, finques o localitzacions molt concretes. 

� Millor resolució per models bidimensionals. 

� Menor utilització de recursos i més velocitat de procés. 

� Facilitat de determinació de les entitats. 

� Estructura de dades complexa. 

� Programari de més dificultat d’implementació. 

Model Raster 
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� Més apte per representació de dades geogràfiques que no necessitin definir exactament el 

seu contorn com zones de població amb unes determinades tendències, informació 

meteorològica, superposició de mapes o dades de grans àrees. 

� Captura ràpida d’informació. 

� Estructura simple de les dades. 

� Facilitat per la simulació i l’anàlisi. 

� Utilitza un gran volum de dades. 

� En la seva presentació ofereix menys resolució. 

 
1.2.5 Principals aplicacions dels SIG 

 
Els SIG van ampliant el seu camp d’aplicació de forma progressiva a tots els àmbits d’anàlisi científic 

on intervenen dades d’ubicació geogràfica. Podem destacar les següents aplicacions concretes: 

� Utilització de mapes per ubicació d’entitats concretes. Empreses de distribució elèctrica, gas, 

ferrocarrils, ajuntaments, Diputacions i Entitats públiques utilitzen un SIG per localitzar 

geogràficament les seves instal·lacions o determinar els seus límits o planificar el seu 

desenvolupament urbanístic. 

� Utilització de mapes quantitatius construïts en base a criteris demogràfics, de densitat o de 

moviments de població. 

� Establiment de rutes òptimes i distàncies entre poblacions. 

� Estudi històric analitzant dispersió de jaciments i relacionant la seva ubicació amb una 

determinada àrea d’influència. 

� Càlcul de distàncies al voltant d’una determinada localització. 

� Prediccions futures en base a un anàlisi històric de l’evolució d’una determinada zona 

geogràfica. 

� Estudis geològics del terreny en base a ortofotografies que defineixen el tipus de substrat. 

� Estudis del trànsit, realització de noves carreteres, ampliacions urbanes, estudis de mobilitat, 

traçat de xarxes de comunicacions. 

� Estudis empresarials de dinàmica de mobilitat de clients per accedir als seus centres comercials. 

1.2.6 Interoperabilitat 

Una de les principals característiques d’un SIG és la facilitat d’integració de dades expressades en 

formats diferents. El sistema ha de tenir la capacitat  de reunir en un sol espai informacions de 

procedència diversa i heterogènia de forma que és puguin visualitzar de forma conjunta per aprofitar les 

especials característiques de cada tipus d’arxiu.  

La interoperabilitat és la capacitat de que sistemes heterogenis puguin intercanviar processos o dades[9]. 

En el cas dels SIG podrem combinar dades del propi sistema amb fulls de càlcul i text per generar 
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informes, plànols i representacions, interactuar amb altres aplicacions com Word, PowerPoint o Acces i 

suportar la majoria de bases de dades existents al mercat com Acces, SQL Server, Oracle o DB2. 

L’OGC, Open Geospatial Consortium, és un Organisme que agrupa a més de 250 organitzacions i que 

té com a principal missió la definició d’estàndards oberts  i interoperables dintre dels SIG[10]. Les 

especificacions més importants sorgides de l’OGC són. 

� GML, Graphic Mark Language, llenguatge de marcat geogràfic 

� WFS, Web Feature Service, proporciona informació relativa a una capa vectorial. 

� WMS, Web Map Services, genera un mapa dinàmicament a partir d’informació geogràfica. 

� WCS, Web Coverage Service, serveix mapes raster a partir d’uns paràmetres. 

� CSW, Web Catalogue Service 

1.2.7 Comparació entre SIG, CAD i SGBD 

Com a darrera consideració en quant als Sistemes d’Informació Geogràfica establim una comparació 

entre els diferents sistemes involucrats en el tractament de dades geogràfiques: 

CARACTERÍSTIQUES SIG CAD SGBD 

Significat 
Sistema d'Informació 
Geogràfica 

Computer Aided Design 
Sistema de Gestió de 
Bases de dades 

Origen 

Integració de dades amb 
components 
geogràfiques en un sol 
entorn. 

Disseny i dibuix de nous 
objectes. 

Gestió de bases de dades 
de tots tipus. 

Tractament de dades 

Gran volum de dades, 
possibilitat de 
georreferenciar, 
superposició de dades i 
capacitat d’anàlisi i 
recerca espacial. 

Menor volum de dades 
que en el SIG, gran 
capacitat gràfica, no pot 
georreferenciar. 

Tracten gran volum 
d’informació 
alfanumèrica però 
disposen de poca capacitat 
gràfica 

Tipus de producte 
Específic pel tractament 
de cartografia. 

General, més enfocat al 
dibuix tècnic. 

General, emmagatzema 
dades de qualsevol tipus 

Interrelació 
El SIG utilitza elements 
de CAD i de SGBD 

CAD és un eina molt 
més especifica. 

Serveix de base per les 
dades en el sistema SIG. 

Software utilitzat  
ArcInfo, ArcView, , 
Framme, Geomedia 
Smartstore, Mapinfo 

AutoCad,  Microstation 

Microsoft Acces, 
Microsoft SQL 
Server,MySQL, Oracle 
Spatial/Locator, 
PostgreSQL/PostGis 

Taula 3: Comparació sistemes de tractament de dades 
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1.3 Introducció a la Cartografia 

Tot sistema d’informació geogràfica utilitza una gran quantitat de conceptes de cartografia necessaris 

per determinar una posició única d’una entitat en la superfície de la terra. En aquest apartat 

desenvoluparem els principals elements cartogràfics necessaris per implementar qualsevol aplicació 

que inclogui un mapa de situació. 

1.3.1 Aproximació històrica a la Cartografia 

Des de sempre ha existit la voluntat humana de representar el mon que l’envolta. A mesura que l’home 

anava ampliant l’horitzó dels seus recorreguts la dimensió del territori que coneixia anava creixent, de 

forma que dels primers mapes locals a l’antiga Mesopotàmia, on es feien representacions en pedra, dels 

voltants de les ciutats, fins a les representacions de Mercator al Segle XVI, on s’efectuen les primeres 

projeccions cilíndriques, cada vegada s’han realitzat representacions més fidels de la realitat. Al Segle 

XVIII neixen les Societats Geogràfiques que organitzen expedicions per recopilar informació cada 

vegada més acurada de forma que el coneixement geogràfic es compila i es millora de forma notable. 

Avui en dia amb la Revolució Tecnològica, la informació geogràfica torna a assolir una importància 

fonamental com a recurs adicional per l’anàlisi de molts aspectes de la realitat, tal com hem descrit a 

l’apartat 5.2.5. 

1.3.2 Nocions bàsiques de cartografia 

La cartografia és la ciència que tracta de representar la totalitat de la superfície terrestre o una part en 

un mapa o plànol. Es descriuen a continuació els principals conceptes necessaris per treballar en la 

construcció d’un SIG. Per la comprensió dels sistemes de referència geodèsics és imprescindible definir 

el concepte de datum, lligat a les figures de l’el·lipsoide de referència i el geoide, els sistemes de 

coordenades, i els diferents tipus de projeccions que donen lloc a la representació d’una superfície 

esfèrica sobre una altra de plana. 

1.3.2.1 Geoide i el·lipsoide de referència 

Com a conseqüència de que l’esfericitat de la terra no és perfecta 

s’ha creat una forma geomètrica aproximada anomenada geoide. 

Es defineix el geoide com la superfície teòrica de la terra que 

uneix tots els punts d’igual gravetat. Aquesta superfície no és 

uniforme, sinó que presenta diferències notables d’alçada entre 

les muntanyes més altes i les profunditats marines. 

La irregularitat de la figura que representa la terra dificulta 

extraordinàriament fer càlculs matemàtics i per tant es busca una 

aproximació a la forma terrestre que els faciliti. La representació 

Fig.8 Forma geoide terrestre [11] 
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matemàtica d’aquesta figura irregular serà l’el·lipsoide de referència que al ser una superfície amb una 

expressió matemàtica senzilla  permet fer 

càlculs més acurats.            

L’el·lipsoide és una simplificació del model 

geoide de la terra que no considera les 

alteracions pròpies de la topografia i que està 

dotada de la similitud suficient  de forma que 

ens permetrà definir punts matemàtics sobre la 

superfície terrestre en forma de latitud i 

longitud. 

Un dels el·lipsoides de referència més utilitzats 

en l’actualitat és el descrit en el sistema Word 

Geodetic System 84 (WGS 84)  desenvolupat pel departament de defensa dels Estats Units i que té com 

a origen el centre de masses de la terra. La seva popularitat es deu a que és utilitzat pel sistema de 

posicionament global (GPS). [13] 

 

1.3.2.2 El Dàtum 

Es defineix el dàtum com el punt d’intersecció entre l’el·lipsoide i el geoide compost pels següents 

elements de referència: [14] 

� Un el·lipsoide definit pels seus dos semieixos major i menor (a,b): 
 

 
 
 
 
 

 
 
 
 

                                                                        Fig.10 semieixos el·lipse [15] 
 

� Un punt anomenat punt fonamental o punt d’origen on l’el·lipsoide i la geoide són coincidents. 

Aquest punt és defineix per les seves coordenades de longitud i latitud.(32) 

 

 
 
 
 
 
 
     

Fig .9 El·lipsoide i geoide [12] 

         Fig.11 Punt dàtum [16] 
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Aquest punt dàtum és un lloc geogràfic que s’utilitza com a referència per situar la resta de punts del 

plànol tenint en compte la projecció que s’ha realitzat. A Espanya per tota la cartografia oficial 

s’utilitza com a punt fonamental [17] una torre situada a la ciutat de Potsdam (a l’est de Greenwich). 

Tots els altres punts utilitzen aquest com a referència. Existeixen molts dàtums donat que cada país 

utilitza la seva pròpia referència i això dóna com a resultat que un mateix lloc geogràfic pot estar 

representat per coordenades diferents pel fet de no utilitzar el mateix punt d’origen. Els més utilitzats a 

Europa són el WGS (World Geodetic System 1984) i el ED50 (European 1950). 

1.3.2.3 Coordenades geogràfiques 

Per representar una posició concreta sobre la superfície terrestre s’utilitzen les coordenades 

geogràfiques. Per especificar aquest concepte amb claredat es necessari introduir les definicions de 

meridià, paral·lel, latitud i longitud. 

Meridians 

Per definició l’eix imaginari de la terra uneix els dos pols oposats, pol sud i pol nord. Per aquest eix on 

la terra gira sobre ella mateixa. Els meridians serien els infinits plans que tallarien la superfície terrestre 

i que tindrien en comú aquest eix central de la terra. Per conveni es sol definir el Meridià 0º, el que 

passa per la ciutat Britànica de Greenwich, que divideix el globus terraqui en dues zones en funció de la 

seva situació respecte a aquest meridià. La zona est estaria situada a la dreta del meridià de Greenwich i 

arribaria fins a la part oposada (antimeridià). Lògicament la zona oest estarà es situarà a l’esquerra del 

meridià fins arribar a l’antimeridià.  

Paral·lels 

Són cercles paral·lels a la línia imaginària de l’equador que divideix la terra en dos hemisferis, el nord o 

septentrional i el sud o meridional. En cada hemisferi existeixen dos paral·lels importants, el tròpic de 

Càncer i el cercle polar àrtic a l’hemisferi nord i el tròpic de Capricorn i el cercle polar antàrtic a 

l’hemisferi sud. Aquests tròpics estan situats a una distància angular de 23º 27’ de l’equador i els 

cercles polars estan a la mateixa distància dels pols. [18] 

Latitud 
Mesura en graus que proporciona la distancia d’un punt respecte a l’equador. Aquesta mesura angular 

va des de els 0º de l’equador fins els 90º als pols, considerant latitud nord o sud en funció de la seva 

situació respecte al paral·lel 0º. 

Longitud 

La longitud situa un punt a l’est o l’oest del meridià de Greenwich (Meridià 0). La seva mesura va des 

de els 0º en els punts situats sobre el meridià de Greenwich fins els 180º dels punts situats a sobre del 

antimeridià. 
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Fig.12 Descripció conceptes coordenades geogràfiques [19] 

 
1.3.2.4 Les projeccions 

 
Per poder representar en forma bidimensional l’el·lipsoide de referència es projecta aquest a diferents 

formes geomètriques tenint en compta que no hi ha cap sistema que pugui presentar fidelment la 

projecció sense cap deformació. Per aquest motiu s’intenta representar la superfície terrestre en una 

projecció que distorsioni el menys possible. El procés de transformar les coordenades geogràfiques de 

l’esfera en coordenades planes per representar una part de la superfície de l’el·lipsoide s’anomena 

projecció.(36) 

El focus de la projecció es pot ubicar a diferents punts donant lloc a diferents tipus de projeccions. 

Aquestes es poden classificar en projeccions cilíndriques, còniques i azimutals o planes. 

En el cas de les projeccions cilíndriques o 

còniques, la figura envolta a l’el·lipsoide i 

en la seva projecció el resultat serà un pla 

en el qual una part de la terra es representa 

mitjançant un sistema de coordenades 

cartesià. 

Una projecció implica sempre una certa 

distorsió de la realitat. L’objectiu de la 

cartografia és intentar minimitzar aquesta 

deformació en la mesura del possible. 

 

Fig. 13 Projecció de l’el·lipsoide sobre un plànol [18]  
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Fig. 14 Tipus de projeccions [18] 

 
El sistema de coordenades més utilitzat en l’actualitat és el sistema de projecció UTM, basat en una 

projecció cilíndrica tangent. 

1.3.2.5 L’escala cartogràfica 

Totes les representacions cartogràfiques han d’indicar quina és la seva proporcionalitat respecte de la 

realitat. Per aquesta raó sempre és necessari especificar quina és la relació entre els objectes reals i els 

representats en un mapa mitjançant una escala. Les escales s’escriuen en forma de fracció on el 

numerador indica el valor del plànol i el denominador el valor de la realitat. Per exemple l’escala 1:500 

significa que 1 cm. del plànol equival a 500 cm. de la realitat. 

Exemples: 1:1, 1:10, 1:500, 5:1, 50:1. 

Si el que es vol és mesurar una superfície, s’haurà de tenir en compte, la relació de figures semblants, 

per exemple un quadrat de 1 cm. de costat al dibuix representarà un àrea equivalent segons l’escala. 

1.3.2.6 Les coordenades UTM (Universal Transverse Mercator) [20] 

Aquest sistema de projecció és ideal per zones longitudinals i estretes on hi ha poca deformació 

respecte de la realitat. Com que les distorsions creixen a mesura que ens anem allunyant de les zones 

Fig. 15 Coordenades UTM 
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més pròximes a les projeccions sobre el cilindre s’ha arribat a dos convenis: 

Fusos: Es divideix la projecció de la terra sobre el plànol en 60 fusos, numerats de l’1 al 60, on cada un 

d’ells està delimitat per dos meridians separats per una longitud de 6 graus sexagesimals. Cal destacar 

que a l’estat espanyol s’utilitzen els fusos 28 (per les Illes Canàries ), 28, 29, 30 i 31. Tanmateix cada 

fus es divideix en 20 bandes des de la lletra C fins a la X (C-M hemisferi Sud, N-X hemisferi Nord) 

Latitud màxima: Per a latituds superiors a 80º les deformacions no permeten l’ús del sistema degut a 

l’excessiva deformació i per tant el rang de latituds màximes acceptades està entre 80º Sud i 84 graus 

Nord. 

Les coordenades UTM estan basades en aquest sistema de projecció, de forma que es pot situar 

qualsevol punt de la superfície terrestre en un sistema de referència cartesià definint els següents 

paràmetres : 

� X(‘easting) i Y (‘northing’) , són les coordenades corresponent a les ordenades i abscisses 

cartesianes dintre del fus.  

� Fus representat per un nombre de l’1 al 60. 

� Zona designada per una lletra de la C fins a la X. 

� Datum. 

1.3.2.6 L’Institut Cartogràfic de Catalunya (ICC) [21] 

A l’any 2007 es van complir els 25 anys de la creació de l’Institut Cartogràfic de Catalunya que com 

especifica a la seva memòria[22] té com a principals objectius: 

� Establir, gestionar, conservar i millorar la infraestructura física i els sistemes tecnològics 

necessaris per a construir i gestionar el sistema de posicionament geodèsic integrat de 

Catalunya. 

� Cobertura de la imatge aèria de Catalunya. 

� Mantenir les bases de dades cartogràfiques. 

� Dirigir i gestionar la Cartoteca de Catalunya. 

� Publicar i difondre productes cartogràfics. 

Entre els productes de l’ICC als quals tenim accés caldria destacar els següents: 

� Cartografia topogràfica a escales 1:5.000, 1:10.000, 1:25.000, 1:50.000, 1:100.000 i 1:250.000. 

� Cartografia Geològica. 

� Ortofotomapes a escales 1:5.000 i 1:10.000. 

� Cobertura mitjançant satèl·lit. 

� Mapes temàtics, Bases temàtiques i geogràfiques i Atles. 

El sistema de referència que utilitza per la seva documentació és: 

� Sistema de referència geodèsic ED50 (European Datum 1950) 

� El·lipsoide Internacional Hayford 1924. 
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� Dàtum Potsdam (Torre de Helmert). 

� Coordenades positives al nord de l’equador i negatives al sud. 

� Origen d’altituds al nivell mitjà del mar a Alacant. 

� Sistema de representació plana conforme a UTM. Catalunya Fus 31. 

 

1.4 Intergraph ® Geomedia® Professional 6.0 

Es descriu a continuació el programari principal utilitzat en la construcció del SIG, Intergraph ® 

Geomedia® Professional 6.0., explicant les seves característiques més importants i les principals 

opcions de treball amb entorns geogràfics. 

1.4.1 Generalitats  

Intergraph ® Geomedia® Professional 6.0 és un eina SIG amb una gran quantitat de funcionalitats entre 

les que podem destacar les següents: 

� Captura, edició i manteniment en alguns casos de les principals bases de dades comercials 

encara que el major grau d’interactivitat s’assoleix amb bases de dades tipus Access. 

� Accepta formats gràfics estàndard a més de capes vectorials i de tipus raster. 

� Funcionament sota entorn Windows. 

� Generació de mapes i informes. 

� Diverses opcions d’anàlisi espacial. 

Les principals opcions del programa es descriuen a continuació: 
 

1.4.2 L’entorn de treball (Geoworkspace) 

 

És un arxiu on es treballa i desenvolupa l’anàlisi de totes les dades geogràfiques. Està format per dues 

finestres: La llegenda buida i la finestra del mapa. 

 

 

 
 
 
 
 
 
 
 
 
 
 

Fig.16 Geoworkspace 
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L’extensió de l’arxiu a desar és .gws i aquí es guarda la configuració del projecte i l’entorn, llegendes, 

consultes i connexions al magatzem de dades. Per crear un espai de treball nou utilitzem una plantilla 

d’un espai existent definida com a normal.gws on especificarem els paràmetres dels elements a 

estudiar. 

1.4.3 El Magatzem de dades (Warehouse) 

Conté la base de dades de les diferents entitats del projecte i les seves dades geomètriques. Per definir 

l’espai de treball s’haurà de fer referència als camps de la base de dades que contingui informació sobre 

les coordenades de les entitats a representar. Geomedia pot establir connexions amb la majoria de bases 

de dades comercials com Oracle, Microsoft SQL Server, Access, si be no en totes les bases de dades és 

té l’opció de lectura/escriptura. En el nostre cas utilitzem la base de dades Acces sobre la qual si que 

disposem d’aquests privilegis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

És imprescindible establir un sistema de coordenades homogeni en el moment d’incorporar qualsevol 

dada georeferenciada per disposar sempre dels mateixos punts de referència. 

Per entendre correctament el sistema de treball del magatzem de dades és necessari definir el concepte 

de metadades. 

Les metadades són dades que descriuen la informació geogràfica facilitant el coneixement d’elements 

com el propietari de les dades, el format, el sistema de coordenades, la seva extensió, etc...  

Fig.17 Metadades del magatzem de dades 
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Un catàleg de metadades permet a l’usuari organitzar, realitzar cerques i accedir a informació 

geogràfica compartida. Qualsevol catàleg ha de tenir eines disponibles per generar, editar i sincronitzar-

se de forma automàtica amb la informació que descriuen les metadades[5]. 

En el moment de crear un nou magatzem, es genera de forma automàtica l’estructura de metadades en 

uns fitxers i taules preestablerts pel programa amb el format següent:    

El contingut d’aquestes taules descriu la informació geogràfica continguda en la Base de dades i dóna 

referències de coordenades, propietaris, sistemes de coordenades utilitzats, format o extensió de la 

informació. 

AttributeProperties 

Es guarden les característiques de cada atribut pels camps que enumera la taula FieldLookUp amb la 

que està relacionada pel camp IndexId que és clau primària en aquesta taula. 

FieldLookUp 

Hi ha tots el camps de les taules creades pel programa, la taula que els conté, el nom i l’identificador 

IndexId que és clau forana de la taula AttributeProperties. 

GAliasTable 

Descriu quina funció ha de tenir cada taula en relació a unes condicions predefinides per Geomedia. 

GCoordSystem 

Emmagatzema les dades dels sistemes de coordenades del Geoworkspace. 

GeometryProperties 

Relaciona la geometria del SIG amb el sistema de coordenades que té associat. 

GFeatures 

Guarda els noms de les vistes disponibles per a les comandes de Geomedia. 

GSQLOperatorTable 

Descripció de les comandes SQL de bases de dades que es poden utilitzar en les consultes. 

Jaciments 

Base de dades creada per l’usuari on hi ha els atributs dels elements a analitzar a l’estudi. 

MFcomStudyAreas 

Informació de les coordenades d’una àrea d’estudi concreta. 

ModificationLog 

Realitza un control de les modificacions efectuades a totes les classes d’entitat. 

ModifiedTables 

Realitza un control de les taules que s’han modificat. 

1.4.4 Les connexions 

És la relació definida entre el magatzem de dades de Geomedia  i la base de dades que conté la 

informació geogràfica. Dintre d’un mateix Geoworkspace poden existir diferents connexions amb 
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diferents tipus de dades de diferents magatzems. Cada connexió utilitza un servidor de dades per 

convertir aquesta informació a un format que el software pugui mostrar. 

1.4.5 Entitats i classes d’entitat 

Les classes d’entitat instanciaran entitats que són els elements de caràcter geogràfic amb els que 

treballarem. En el moment de definir una classe d’entitat especificarem les característiques gràfiques i 

els atributs que tindran les entitats d’aquesta base de dades. Un exemple seria la classe d’entitat 

jaciment, i el seus atributs estan definits a la base de dades corresponent: Tipus de jaciment, època, 

funció, coordenades, toponímia moderna del lloc, toponímia antiga del lloc, etc. Les entitats serien els 

diferents jaciments situats a les diferents poblacions del Baix Llobregat. 

1.4.6 Llegenda 

Amb la llegenda es determinen les entitats que es mostraran a la finestra del mapa i el seu aspecte 

visual. La llegenda està formada per dues parts: la barra del títol i un cos on existeix la definició de 

cada entitat.  

Fig.18 Llegenda i entitats 

 

 

 

 

 

 

Fig.19 Finestra de dades 
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Visualment amb l’opció finestra es podrà alternar entre l’aspecte gràfic i les dades alfanumèriques que 

generen aquestes entitats. 

1.4.7 Consultes 

De la mateixa forma que en una base de dades convencional Geomedia permet seleccionar diferents 

elements geogràfics del magatzem de dades en funció d’un criteri determinat escollit. Els criteris de 

selecció es poden aplicar sobre els atributs de la base de dades, com per exemple seleccionar els 

jaciments que pertanyen a una determinada població. 

Les consultes espacials inclouran a més, criteris de tipus alfanumèric, com per exemple seleccionar els 

jaciments que estiguin en un radi determinat per unes coordenades concretes. 

1.4.8 Formats de dades  

Es defineixen els principals formats de dades amb els quals pot treballar Geomedia i les principals 

opcions per carregar arxius de format gràfic. 

1.4.8.1  Dades de tipus vectorial 

Les dades gràfiques de tipus vectorial es carreguen al SIG de forma directa si els arxius es volen 

visualitzar únicament i aquests són de tipus Microstation amb extensió DGN. 

Si es vol que les dades vectorials amb extensió DGN formin part del projecte s’haurà de seguir el 

següent procés: 

1. Definir l’arxiu de sistema de coordenades amb extensió .CSF. Per fer això transformem l’arxiu 

en format .DGN, que incorpora el sistema de coordenades en el propi dibuix simplement 

canviant l’extensió per .CSF.  

2. Definir l’arxiu de definició de servidor CAD amb extensió .CSD. Aquest arxiu indica al 

programa els arxius de disseny amb els que es treballarà i les entitats que s’extrauran de cada 

un d’ells.  

3. Seleccionar l’arxiu de sistema de coordenades i crear les classes d’entitat, relacionant les 

diferents simbologies del dibuix CAD amb cada una de les noves classes d’entitat que es 

vulguin incorporar al projecte.  

Entre d’altres tipus d’arxius en format vectorial amb els que treballa Geomedia existeix un format que 

s’ha convertit en estàndard per l’intercanvi d’informació geogràfica entre SIG: és l’ESRI (Enviromental 

Systems Research Institut) Shapefile (SHP).  

Un Shapefile es generat per varis arxius, encara que com a mínim haurà de disposar de tres, un arxiu 

amb extensió .shp on s’emmagatzemen les entitats geogràfiques dels objectes, un altre amb extensió 

.shx on s’emmagatzema l’índex de les entitats geomètriques i el darrer amb extensió .dbf on 

s’emmagatzema la informació dels atributs dels objectes. Addicionalment disposarà d’arxius 

representatius de les metadades i la projecció cartogràfica..[23] 
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1.4.8.2 Dades de tipus raster 

Es poden carregar imatges en format MrSID o Geotiff seleccionant la imatge a carregar per a posar-la 

com a fons de l’espai de treball. Si es vol que la imatge carregada estigui georeferenciada es necessita 

determinar les coordenades. Si la imatge està en format Geotiff aquesta informació ja va incorporada en 

el mateix arxiu. Pel format MrSID caldrà georreferenciar l’objecte una vegada introduït a Geomedia, tot 

i aquesta desavantatge la seva utilització és recomanable degut a la menor utilització de memòria 

d’aquest format. S’haurà de tenir en compte que el sistema de coordenades sigui el mateix que el que 

hem determinat a l’espai de treball. 

1.4.9 El mòdul Grid de Geomedia 

Geomedia Grid és un producte extensió del programa principal  que s’insereix com a opció dintre de la 

plataforma  Geomedia. Les principals característiques del producte són: 

� Permet anàlisis complexes entre multiplicitat de capes de reixes (grid) raster. 

� Realitza conversió de dades vector-raster i raster-vector. 

� Processa i filtra algoritmes sobre grids. 

Permet definir aspectes de les reixes de cada capa com: 

� Valors de cada cel·la que constitueix el grid. 

� Resolució, localització, i aparença de cada cel·la. 

� Distribució del grid en zones. 

� Assigna una denominació a cada zona en forma de llegenda. 

En quant a l’emmagatzemament de dades les capes grid són desades en un format específic amb 

extensió .mfm. L’àrea d’estudi i la informació de les capes grid es guarda al magatzem de dades 

corresponent. 

1.4.10  El mòdul Terrain de Geomedia 

Geomedia Terrain és un producte extensió del programa principal que s’insereix com a opció dintre de 

la plataforma  Geomedia. Les principals característiques del producte són: 

� Permet la visualització en 3D de models digitals del terreny. 

� Generació de perfils del terreny al llarg de línees i corbes de nivell. 

� Realització de simulació de vol sobre el terreny. 

El mòdul funciona creant un entorn tridimensional en una finestra 3D on el sistema permet seleccionar 

les entitats, imatges i models d’elevació que es vulguin incorporar i escollir els paràmetres de 

simbologia i visualització com poden ser l’alçada d’edificis o la projecció de carreteres sobre el terreny. 

Una vegada que aquestes entitats estan importades, s’obre una finestra de navegació per poder volar 

sobre el terreny i si es vol, gravar arxius en format avi. 
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2 Treball Pràctic  

    El riu Llobregat i la seva relació amb el territori a l’època romana 

2.1 Introducció 

En el treball pràctic es tracta de determinar la relació entre el traçat del riu Llobregat i els assentaments 

romans de l’època. Primerament s’enumeren i descriuen els jaciments la seva ubicació geogràfica i 

toponímia. Amb aquesta informació es construeix la base de dades que permetrà desenvolupar el SIG. 

Amb la informació de la base de dades es comença a construir el Geoworkspace amb la capa de vies 

romanes i els punt geogràfics que venen determinats en els camps corresponents de l’arxiu de 

jaciments. 

2.2 Recull de dades i toponímia dels jaciments 

Amb els següents apartats es descriu el procés de captació de les dades, la seva modificació per ampliar 

la informació i sistematitzar-la de cara a l’anàlisi, un recull de la toponímia de la zona i la seva 

conversió en un format de base de dades apta per ser utilitzada per Geomedia. 

2.2.1 L’arxiu de jaciments 

Inicialment es disposa d’un full de càlcul tipus Excel, anomenat jaciments.xls on estan especificats el 

nom i les característiques principals de 112 jaciments romans a l’entorn de la riba del riu Llobregat. 

L’arxiu està incomplert sobre tot en l’apartat referent a la cronologia. Per fer més operativa aquesta 

tasca es reparteixen tots els jaciments entre els 14 membres que realitzen l’estudi de forma que els 

jaciments que s’assignen són els següents: 

 

ID MUNICIPI JACIMENT X Y Z TIPOLOGIA CRONOLOGIA 

41 Castellví de Rosanes Torre de l’homenatge 409840 4589585 365 Torre   

42 Castellví de Rosanes Vinya de San Sunyer 412700 4590100 63 Vil·la   

43 Cornellà de Llobregat Ajuntament de Cornellà 422320 4578810 25 Vil·la   

44 Cornellà de Llobregat c/ Ametller, 4 422320 4578785 26 Sitges   

45 Cornellà de Llobregat Castell de Cornellà 422435 4578665 18 Vil·la s II aC - ? 

46 Gavà Serra d’en Valls 415900 4572100 15 Vil·la   

47 Gavà Turó de Calamot 415800 4572850 87 Poblat   

48 Gavà Mina de Can Tintorer 416400 4573850 41 Mina Neolític-Romà 

    Taula 4: Registres de jaciments. Atributs principals 

 

Una vegada realitzada la revisió s’obté el següent resultat: 
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ID MUNICIPI JACIMENT X Y Z TIPOLOGIA Inici Fi IBÈRIC ROMÀ 

41 Castellví de Rosanes Torre de l’homenatge 409941,51 4589786,9 365 GUA -27 192 0 1 

42 Castellví de Rosanes Vinya de Can Sunyer 412801,54 4590301,9 63 VIL -218 192 0 1 

43 Cornellà de Llobregat Ajuntament de Cornellà 422421,63 4579011,8 25 VIL 284 1150 0 1 

44 Cornellà de Llobregat c/ Ametller, 4 422421,63 4578986,8 26 SIT -650 476 1 1 

45 Cornellà de Llobregat Castell de Cornellà 422536,63 4578866,8 18 VIL -650 476 0 1 

46 Gavà Serra d’en Valls 416001,56 4572301,7 15 VIL 14 476 0 1 

47 Gavà Turó de Calamot 415901,56 4573051,7 87 POB -450 14 1 0 

48 Gavà Mina de Can Tintorer 416501,57 4574051,7 41 MIN -650 476 1 1 

   Taula 5: Registres de jaciments amb informació millorada 

On s’han realitzat les següents aportacions i millores: 

� Transformació de les coordenades que es suposa que estan en format Dàtum WGS84 a ED50 

utilitzant la calculadora CoordTrans v 3.2. 

� Aportació de la cronologia calculada del jaciment creant un camp inici i un camp final indicant 

les dates aproximades de la vida de l’assentament, substituint el camp únic “Cronologia”. 

� Establiment de dos camps booleans en cas de que el període d’existència del jaciment 

coincideixi amb períodes ibèrics o romans. 

� Normalització de la tipologia amb els següents acrònims: 

Acrònim Definició 
BOB Bòbila 
CEN Centuriació 
CER Ceràmica 
CIU Ciutat 

EI / ER Establiment ibèric i/o republicà 
EIB Establiment ibèric (rur.) 
ERU Establiment rural 
ETN Ètnia 
FLU Riu 
GUA Torre, fortificació, p.guaita 
MAN Mansió 
MON Monestir aïllat /arc monestir 
PEC Pesi 
PED Pedrera 
POB Poblat ibèric 
PRE Presa 
SAN Santuari 
SIT Camp sitges aïllat 
TOM Enterrament/s aïllat 
VAR Varis. Indeterminat 
VIL Vil·la 

Taula 6: Acrònims jaciments 
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La informació dels jaciments ressenyada està obtinguda, essencialment de la pàgina web: 

http://cultura.gencat.net/invarque/index.asp i es troba adjuntada a la documentació del treball amb 

l’arxiu jaciments 6.xls. 

Una vegada tots els membres de l’aula han efectuat totes les aportacions queda completat l’arxiu 

jaciments_Llobregat_complet.xls (també s’adjunta amb la documentació) que ens servirà de base per a 

la realització de l’estudi geogràfic. 

Sorgeix el dubte de si les coordenades estan totes referides al mateix datum, donat que es possible que 

hi hagin coordenades en Datum ED50 i d’altres en WGS84. La decisió que es pren en principi és 

continuar amb el treball geogràfic i intentar corregir les incongruències a mida que anem desenvolupant 

les qüestions plantejades. 

2.2.2 Toponímia dels noms dels jaciments estudiats 

L’origen de la toponímia dels municipis on hi ha els jaciments té en la seva majoria origen llatí. En la 

taula següent hi ha Informació i referència sobre la possible procedència dels topònims de la zona. 

 

Informació i referències Topònim actual Topònim antic Notes d’origen 

http://www.espaisvirtuals.com/grupbrea/index.html?lang=es&target=d41.html Abrera Breda 
S X, Origen incert potser 

germànic 

http://classicat.net/llocs.pdf Castellbisbal 
Kastro 

Adalasindo 
S IX, compost format per 
castell derivat del llatí 

http://classicat.net/llocs.pdf 
Castellví de 
Rosanes Castelu Vetulu S X, castell vell 

http://classicat.net/llocs.pdf 
Cornellà de 
Llobregat Cornelius 

Derivat de l’antropònim 
CORNELIUS 

http://classicat.net/llocs.pdf Gavà Gavanum 
S XI, deriva de l’antropònim 

llatí GAVIUS 

http://classicat.net/llocs.pdf 
L'Hospitalet de 

Llobregat Hospitalis S XII, (alodio)Hospitalis  

http://es.wikipedia.org/wiki/Molins_de_Rei Molins de Rei Molinos del Rey S XII Alfonso II el casto 

http://classicat.net/llocs.pdf Pallejà Pallaiano 
S X, derivat de l'antropònim 

llatí PALLADIUS 

http://www.elpapiol.es/anem/historia.asp Papiol Papiola apuntada 
S XIII Planta abudant al 

voltant castell 

http://www.sabarca.cat/ciudad/historia/default.php?secid=116&docid=132 
Sant Andreu de la 

Barca Saguatosis 
S XII Antigament Sant 
Andreu Aiguestortes 

http://es.wikipedia.org/wiki/San_Baudilio_de_Llobregat 
Sant Boi de 
Llobregat 

Sent Boy, Sant 
Boy 

S XIV, parròquia de Sant 
Baldiri 

http://www.ayuntamiento.es/sant-feliu-de-llobregat 
Sant Feliu de 
Llobregat Feliu 

S XI , ermita dedicada al sant 
dóna nom a lloc. 

http://jordilon.googlepages.com/educaci%C3%B3ambientalbibliografiaiwebs3 Sant Joan Despí Sant Joan del Pi 
SXI, fundació parròquia Sant 

Joan Baptista  

http://www.histocat.cat/pdf/descatalanitzar.pdf Sant Just Desvern 
Sant Just Des 

vern 
Fa referència a un arbre amb 

article salat occità 

http://es.wikipedia.org/wiki/Sant_Vicen%C3%A7_dels_Horts 
Sant Vicenç dels 

Horts 
San Vicen dels 

ortis 
Camps de cultiu al Baix 

Llobregat 

http://www.viladecans.net/jsp/QUEM_SONA/luengo1.htm Viladecans valis canis SXI, possible "vila de gossos" 

   Taula 7: Informació de la toponímia dels jaciments 

2.2.3 La base de dades amb els components geogràfics 

El primer pas per poder treballar amb Geomedia és convertir les dades proporcionades en format .xls a 

un tipus de dades amb el que el programa pugui treballar. Les bases de dades Access tenen gran 

versatilitat i a més tenen privilegis de lectura/escriptura tal com s’ha justificat al punt 5.4.3. El traspàs 

de les dades dels jaciments a Access és automàtic generant els mateixos camps definits al full de càlcul. 

Després de la conversió s’obté la base de dades Riu Llobregat.mdb. 
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   Fig. 20 Base de dades access amb la taula de jaciments 

2.3 Càrrega de l’arxiu de jaciments a Geomedia 

Es descriu a continuació la construcció de les dades bàsiques de la construcció del SIG i la càrrega de la 

base de dades que ja s’ha convertit a Access dintre del programari de Geomedia. 

2.3.1 Construcció del Geoworkspace 

Per definir el nou espai de treball (geoworkspace) s’utilitza la plantilla existent (normal.gws) i 

l’anomenem SIGLlobregat.gws. 

Es defineix el sistema de coordenades que farà servir el SIG per tot l’àmbit del projecte amb l’opció 

View -> Geoworkspace Coordinate System... 

De la mateixa forma es crea un arxiu extern que ens referirà correctament totes les dades de tipus CAD. 

Amb l’opció Guardar Como es genera l’arxiu SIGLlobregat.csf que servirà per tots els fitxers CAD. 

 
 
 
 
 
 
 
 
 

Fig.21: Establiment de sistema  de coordenades  
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Les dades de configuració seran: 
 

� Sistema de projecció UTM, hemisferi Nord i Fus 31 (correspon a la zona de Catalunya) 

� Datum Geodèsic Europeu 1950. 

� Unitats de mesura mètrica i de mesura angular en graus. 

2.3.2 Càrrega dels punts de jaciments i arxiu de vies romanes 

Una vegada definit l’espai de treball s’han d’establir les connexions amb els magatzems de dades per 

anar configurant les diferents capes que constituiran el nostre SIG. 

2.3.2.1 connexió amb la base de dades de Jaciments 

Es selecciona Warehouse -> New Connection i s’estableix una connexió tipus access amb la Base de 

dades Jaciments.mdb. Per una banda s’obtindrà la distribució dels punts georeferenciats i d’altra banda 

l’estructura dels camps i registres de la base de dades, que, al ser de tipus access permet les opcions de 

lectura i escriptura. 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
                                        Fig. 22: Connexió de Geomedia amb la Base de dades 

 
Es pot alternar la vista de la base de dades i els punts georeferenciats si es selecciona Window -> 

MapWindow1, per veure els punts o Window -> DataWindow1, per veure i modificar, en cas necessari 

la base de dades. 

2.3.2.2 Connexió amb la capa de vies romanes 

Per obtenir la primera capa d’anàlisi de les vies romanes s’estableix una connexió del tipus ArcView 

amb el directori on hi ha els arxius amb extensió .SHP, (aquests arxius han estat proporcionats en un 

fitxer comprimit CapaViesRomanes.Zip). S’assigna el mateix sistema de coordenades que el que s’ha 
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fixat per la base de dades. Una vegada establerta la connexió es comprova que dintre del geoworkspace 

hi han dues connexions obertes: 

 

 
Es selecciona Legend ->Add Legend Entries per situar les entitats a l’espai geogràfic i si aquestes estan 

correctament georeferenciades s’obtenen els punts geogràfics dels jaciments correctament ubicats dintre 

de la capa de vies romanes: 

 
  Fig.24: capa de vies romanes i punts dels jaciments georreferenciats 
 
Amb el geoworkspace correctament configurat i els punts ubicats en la posició correcta es comença a 

treballar en l’anàlisi de les diferents qüestions plantejades. 

2.3.2.3 Càrrega de les Ortofotografies al SIG 

Una vegada s’han situat geogràficament els punts d’estudi de forma vectorial es realitza la càrrega de 

mapes tipus raster amb els que es podrà relacionar amb la realitat les entitats definides a la Base de 

dades. 

El primer pas consistirà en descarregar de la pàgina de l’ICC[21]  els mapes amb els quals es vulgui 

situar el nostre espai d’estudi. Es seleccionen els mapes de tipus ortofotoimatge pel seu aspecte visual 

on simultàniament es pot tenir una visió geomètrica, en forma de coordenades i d’altra banda un 

acostament a la realitat donat que s’obté la situació de la zona objecte d’estudi en forma de fotografia 

aèria.  

Fig. 23: connexions amb els magatzem de dades 
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Es selecciona l’escala 1:5.000 que és la que proporciona una definició dels objectes més gran encara 

que d’altra banda suposa una tasca addicional de càrrega i definició de coordenades de cada quadrícula. 

Lògicament seran les quadrícules del mapa on hi hagin punts georeferenciats les que interessen pel 

nostre estudi i les que s’hauran de descarregar. 

 
 
 
 
 
 
 
 
 
 
 
 
Les quadrícules de l’Institut Cartogràfic de Catalunya corresponen a coordenades cartesianes 

emmagatzemades en fulls. Es seleccionen les que corresponen a l’àrea de treball a estudiar i que 

representen localitzacions del Baix Llobregat: 

    coordenada horitzontal del full ICC 

    283 284 285 286 287 288 289 

119 
Sant 

Hilari             

120 Abrera Ca n'Ametller           

121 Can Bros Can Santeugini Can Serrafosa         

122 
Martorel

l Can Coromines Castellbisbal         

123 

Castellví 
de 

Rosanes 
Sant Andreu de la 

Barca El Papiol 
La Colònia 
Montserrat       

124 
Corbera 
de Dalt Can Montmany Pallejà 

Sant 
Bartomeu de 
la Quadra       

125 

Corbera 
de 

Llobrega
t 

La Palma de 
Cervellò Molins de Rei 

Santa Creu 
d'Olorda Can Merlés     

126 Vallirana Cervelló 
Sant Vicenç 
dels Horts 

Sant Feliu de 
Llobregat 

Sant Just 
Desvern     

127 

Mas de 
Les 

Fonts 
Les Cases del 

Frare 
Santa Coloma 
de Cervelló 

Sant Joan 
Despí 

Cornellà-
Esplugues 

L'Hospitalet-
Sants   

128 
Santa 

Eulàlia Torrelletes 
Sant Climent de 

Llobregat 
Sant Boi de 
Llobregat Almeda Bellvitge   

129 Begues 
Castell 

d'Eramprunyà Viladecans Sales 
El Prat del 
Llobregat Zona Franca 

Far del 
Llobregat 

130 
La 

Morella La Sentiu Gavà Les Marines 
Aeroport de 
Barcelona 

Estany de la 
Ricarda 

Moll del 
Prat 

co
or
de
n
ad
a 
ve
rt
ic
al
 d
el
  f
u
ll
 I
C
C
 

131 
Turó de 
Vallbona Castelldefels Canal Olímpic  La Murtra 

Estany del 
Remolar Platja del Prat   

              Taula 8: Distribució de quadrícules raster al SIG. 

Figura 25 Ortofotoimatges de l’ICC[21]  
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El procediment per carregar les imatges raster en el programa Geomedia és el següent, tenint en compte 

que s’haurà de repetir tantes vegades com quadrícules en qualsevol format es vulgui descarregar: 

 
1. Es descarrega i descomprimeix el fitxer obtingut de l’ICC. S’obtenen 4 arxius amb extensions 

.xml, .sdw, una Imatge en format MrSid i un document de text. Per visualitzar les imatges en 

aquest format es necessita el visor MrSid GeoViewer 2.1 de LizardTech[24]. 

2. Les imatges descarregades no estan georreferenciades i per tant s’hauran de calcular les 

coordenades corresponents a les quatre cantonades de la quadrícula per situar-la de forma 

correcta al nostre SIG. A l’arxiu de text s’obtenen les coordenades de la cantonada superior 

esquerra, l’alçada i amplada en metres i la precisió:  

 

 

3. Amb aquesta informació es calculen les quatre coordenades (UTM, ED50): 

X1 Y1 Amplada Alçada Resolució_X_Y 
407765,75 4583495,25 7031 4718 0,5 

      S’utilitza una matriu affine[25] per calcular les coordenades: 

Coordenada inferior esquerra Coordenada superior dreta Coordenada inferior dreta 

 X2=X1+(Amplada-1)*Resolució_X X3=X1+(Amplada-1)*Resolució_X X4=X1 

Y2=Y1 Y3=Y1-(Alçada-1)*Resolució_Y Y4=Y1-(Alçada-1)*Resolució_Y 
Taula 9: Càlcul de coordenades amb matriu affine 

      Coordenades de les cantonades: 

superior esquerra superior dreta inferior esquerra inferior dreta 
407765,75 411280,75 407765,75 411280,75 
4583495,25 4583495,25 4581136,75 4581136,75 

Taula 10: Exemple de càlcul de les coordenades de la quadrícula 

 

4. Es crea un magatzem nou per guardar les referències a les imatges amb l’opció Warehouse -> 

New Warehouse. Es fa servir una plantilla normal.mdt i s’anomena al magatzem d’imatges 

MrSid ImatgesMrSid.mdb. 

5. Es crea una taula de tipus Image amb l’opció New Warehouse-> Feature Class Definition    -> 

New. Aquí es selecciona el tipus de Geometria (seleccionem Image) i el sistema de 

coordenades que per homogeneïtat s’ha de fixar amb els mateixos paràmetres que a la resta del 

Geoworkspace (ED50, UTM i fus 31). 
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6. Inserció de la imatge amb l’opció Insert -> Interactive Image, seleccionant el magatzem on es 

tenen les imatges, i la classe d’entitat. Es dibuixa un àrea sobre la pantalla on s’insereix la 

imatge. 

7. Al ser una imatge no georreferenciada s’han d’introduir les coordenades calculades prèviament. 

Es selecciona la quadrícula inserida en el pas anterior i es situa en la posició geogràfica 

correcta. Agafem l’opció Tools -> Image Registration -> New. S’obté la següent pantalla on 

pas a pas hem d’introduir les quatre coordenades. A mesura que s’introdueixen els punts 

aquests s’aniran definint al nostre Geoworkspace indicant quina serà l’àrea on es situarà 

definitivament la quadrícula ben georeferenciada. És important Registrar i Desar cada 

quadrícula i comprovar la correcta situació respecte de la nostra àrea geogràfica. 

 

 

Figura 26: Pantalla d’introducció coordenades quadrícules raster 

 

Una vegada s’ha repetit el procés tantes vegades com quadrícules vulguem inserir obtenim l’àrea 

d’estudi on podrem situar els jaciments del nostre estudi en el seu context geogràfic. 
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Fig.27 Ortofotomapa de la zona d’estudi Baix Llobregat i curs actual Riu Llobregat 

 
 
2.4 Definició de les classes d’entitat 
 
Treballarem ara, en classificar adequadament els jaciments distribuïts al llarg del riu Llobregat en 

funció de la seva tipologia. S’utilitza l’eina que ens proporciona Geomedia per dissenyar símbols que 

més tard s’inclouran com a informació a la llegenda. 

Seleccionem l’opció Window -> Show Layout Window. 

En aquesta pantalla podem dissenyar els símbols 

utilitzant les eines de dibuix que ens proporciona el 

programa. Una vegada finalitzat el símbol fem Edición 

->Seleccionar todo. A continuació Draw -> Create 

simbol. S’haurà de seleccionar el nostre símbol fent un 

doble clic sobre el mateix. En el cas d’aquest estudi 

s’ha creat un directori anomenat símbols on guardarem 

els tretze dissenys representatius de les tipologies 

estudiades. 

Fig.28 disseny de l’entitat “aqüeducte” 
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Aquests arxius tindran l’extensió .sym i serviran per crear la biblioteca de símbols que s’aplicarà en el 

nostre SIG. Existeix també la possibilitat d’utilitzar gràfics creats amb AutoCad (.dwg) o Microstation 

(*.cel). 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
El següent pas serà crear l’arxiu Geomedia Feature Symbol File (.fsm) amb el qual es treballarà per 

inserir les diferents tipologies. Per realitzar aquesta tasca es seleccionen opcions externes al programa 

Geomedia: Geomedia Professional -> Utilidades -> Definir Archivo de Simbolo. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

           Fig 30. Creació de l’arxiu .fsm 
 

S’afegeixen tots els símbols amb extensió .sym i es crea un arxiu amb extensió .fsm que contindrà tots 

els símbols amb la tipologia dels jaciments. 

 
 

Fig. 29 arxius amb extensió .sym 
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Una vegada definits els símbols s’incorporen al nostre SIG. Es selecciona Legend -> Add Thematic 

Legend entry. Es selecciona la nostra entitat dels punts dels jaciments georeferenciats, s’esculleix 

l’opció Unique Value 

Thematic 

Quan es selecciona 

l’atribut TIPOLOGIA de 

la base de dades, 

Geomedia classifica i 

numera els jaciments 

diferenciant amb colors 

diferents cada tipus. 

Quan s’accepta aquesta 

classificació la llegenda 

es veu ampliada amb els 

punts diferenciats per 

colors segons la seva 

tipologia.  

                 Fig 31. Classificació de l’atribut tipologia 

 
Per incorporar la simbologia que s’ha dissenyat amb l’arxiu .fsm, s’ha de seleccionar cada valor de 

l’atribut (amb el botó dret) i l’opció Style Properties.En aquesta pantalla és on s’indiquen l’origen de 

l’arxiu de símbols que 

ens servirà per 

classificar cada sub- 

entitat de la classe 

d’entitat jaciments 

classificats per la seva 

tipologia i ara també 

amb un indicador que 

serveix de referència 

per identificar-lo. 

 
 
 

            Fig.32 Incorporació als SIG dels símbols de l’arxiu .fsm 
 
Finalment s’obté el SIG amb els símbols georeferenciats i situats sobre les ortofotografies indicant els 

diferents tipus de jaciments. 
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Fig.33 Simbologia dels jaciments associada al SIG 

 

2.5 Informació de les classes d’entitat 
 
Geomedia permet obtenir informació instantània del jaciments simplement fent un doble clic sobre el 

símbol a consultar. Addicionalment podem incorporar més informació associant cada punt a arxius 

externs. La Informació mostrada correspon als atributs definits a la base de dades Acces que permet 

inclús la seva modificació al tenir privilegis de lectura-escriptura, encara que també és possible 

restringir-los si en la seva connexió es defineix com d’accés de lectura únicament.  

Per completar la informació s’ha definit un nou atribut a la base de dades access anomenat vincle 

informació, que permetrà completar la consulta amb un hipervincle a un arxiu extern que mostrarà 

informació addicional en forma d’arxiu .pdf, foto o qualsevol altre arxiu extern. Aquest procés es 

realitza seleccionant la pantalla de dades.  

Una vegada afegit l’atribut, es 

selecciona la cel·la i amb 

l’opció Insert -> Hypertext, 

s’introdueix el vincle a 

l’adreça absoluta on es guarda 

la informació addicional. 

Es comprova el seu 

funcionament en les següents 

consultes. 

 

 

 

Fig.34 Hipervincles a arxius externs 
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2.5.1 Consulta de Jaciments 1: Termes Romanes de Sant Boi de Llobregat 

Fent doble clic sobre el símbol de les termes de Sant Boi de Llobregat s’obté la informació associada 

als seus atributs. Si es torna a fer doble clic sobre l’hipervincle obtenim més informació  

 
Fig. 35 Consulta Termes romanes de Sant Boi de Llobregat 

 
2.5.2 Consulta de Jaciments 2: Pont del diable Castellbisbal 
 
Amb el mateix procés es selecciona el pont romà sobre el riu Llobregat. 
 

 
Fig. 36 Consulta 2 Pont del diable Castellbisbal 
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2.6 Digitalització del traçat del riu Llobregat a l’època romana 
 
Per fer la hipòtesi de traçat del riu Llobregat a l’època romana es poden distingir dues zones d’estudi: 

Una la zona de la desembocadura del riu corresponent a l’actual delta i l’altra la del curs del riu entre la 

desembocadura i l’actual població de Martorell. 

2.6.1 La zona de la desembocadura del riu Llobregat 

Aquesta zona ha experimentat una profunda variació des de l’època romana fins ara. La major part del 

delta actual estava submergida. La desforestació de la vall del Llobregat provocada per l’increment de 

superfície conreada a la recerca de terres més productives degut a tècniques agrícoles deficients va 

produir l’erosió continuada del 

terreny i l’arrossegament de 

sediments cap a la seva 

desembocadura formant l’estuari del 

riu actual. De fet l’origen del nom 

del riu Rubricatum, “vermellós”, es 

deu a la terra argilosa que 

transportava[26]. 

Els punts principals que determinen 

el perfil costaner a l’època romana 

estaria limitat pels punts següents: 

 

 

 

 

� El  principi de les troballes de restes de naus romanes situen l’antic embarcador romà entre els 

jaciments de Les Sorres a Gavà i el de La Marina per tant la línia de la costa hauria d’estar 

situada entre aquests jaciments i l’interior. 

� Han estat considerats com jaciments costaners els de Can Valls del Racó, La Roca i Sant Pere a 

la població de Gavà, el de Santa Maria de Sales a Viladecans les Termes de Sant Boi i el de 

Santa Eulàlia de Provençana a l’Hospitalet[28]. 

Amb aquests indicis es pot unir digitalment els punts anteriorment esmentats per traçar una línia de 

costa  aproximada. El procés per obtenir-la és el següent: 

S’insereixen les etiquetes corresponents a l’atribut Jaciment en cada punt amb l’opció Insert -> Label. 

D’aquesta forma es crea la classe d’entitat que mostrarà el nom de cada Jaciment al Geoworkspace. 

Per seleccionar els Jaciments que interessin per realitzar la traça digital s’utilitza una consulta limitada 

als punts que descriuen la línia de la costa: Analysis -> Attribute Query 

        Fig.37 Variació de la costa a l’alçada de Gavà.[27] 
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Aquí es selecciona l’entitat sobre la qual es fa la selecció, es a dir sobre les etiquetes que hem inserit 

anteriorment i que podem tenir inactives amb l’opció Display off. 

Es selecciona Filter i amb els corresponents operadors es dissenyarà la consulta per obtenir els 

Jaciments que s’han considerat: 

 

Fig. 38: Filtre d’etiquetes dels Jaciments 
 
Per digitalitzar la línia de la costa unim els punts seleccionats anteriorment amb l’opció Insert -> 

Feature, on seleccionem l’entitat de punts que volem unir i l’eina lineal. Capturem els punts a unir per 

obtenir la següent traça digital: 

Fig.39 Línia de la costa a l’època romana digitalitzada 

 
 
2.6.2 El curs del riu al Baix Llobregat a l’època romana 
 
El recorregut del riu entre la desembocadura i la zona de Martorell és més previsible donada 

l’apreciable llera del riu visible perfectament a les ortofotografies. En tot cas definim uns punts que 
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amb tota probabilitat pertanyien a les proximitats del curs del Rubricatum segons la informació 

recavada.  

Per coherència amb el traçat costaner aproximem la desembocadura del riu fent-la coincidir a la línia de 

la costa a prop de l’embarcador de La Marina i a l’ample llera del riu a prop del jaciment del casc antic 

de Cornellà. 

El riu havia de seguir un traçat lineal pràcticament coincidint amb el curs actual fins la zona de 

jaciments de Sant Vicenç dels Horts on els restes de forns per a la construcció d’àmfores. Aquests 

elements es trobaven relativament a prop del riu, riera o prop del mar[29] per afavorir les condicions de 

transport de les mercaderies, vi principalment. 

Al Jaciment de Riu Llobregat es van trobar restes que indicaven la possible existència d’un 

embarcador. 

Al Jaciment de Can Tintorer és troba un jaciment d’un forn també indicatiu d’activitat fluvial. 

El Pont del Diable a prop de la confluència amb la riera de Rubí constitueix un punt fix del recorregut. 

Finalment l’existència d’una gran vila situada al jaciment de Sant Hilari corrobora el recorregut seguit 

pel riu. 

Amb la informació anterior seguim el mateix procés que en la digitalització de la costa obtenint el 

traçat digitalitzat del riu.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                            Fig.40 Traçat del riu Llobregat a l’època romana 
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2.7 Estudi d’un model digital del terreny (MDT)  amb Geomedia Grid 
 
S’estudia en aquesta fase un model digital del terreny (MDT) en base a arxius Ascii proporcionats de 

forma que es puguin visualitzar conques de drenatge i vistes 3D de la zona d’estudi. 

2.7.1 Càrrega i visualització del MDT 

Es selecciona un nou warehouse normal.mdt anomenat EstudiMDT on es guarden les referències dels 

arxius relacionats amb el MDT. Es comença la lectura del MDT amb Grid -> Study Area -> Import 

Files. Aquí es selecciona l’arxiu amb extensió .asc i l’arxiu de coordenades amb extensió .csf amb el 

sistema de coordenades del MDT. Seleccionem el pas de malla de resolució 15 metres. 

Amb Grid -> Layer-> Information es pot seleccionar el MDT  anterior i fixar les unitats de mesura en 

metres. 

Es visualitza l’arxiu amb Grid -> Visualization -> Shaded Relief per obtenir la vista següent: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
        Fig.41 Model Digital del Terreny Pas de Malla 15 m. 
 
2.7.2 Millora del relleu ombrejat 
 
Geomedia Grid permet millorar el relleu capturat amb 

l’opció Visualizacion -> Blending. Al quadre següent 

s’afegeixen les capes amb les que es treballarà per 

millorar l’aspecte visual amb el botó afegir capes: 

 

 

 

 

 

Fig.42 Quadre de selecció per millorar el 

relleu de la capa 
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Amb les capes escollides es pot millorar l’aspecte amb les opcions Legend, on es podrà variar els colors 

de cada grup de píxels i amb l’opció settings es podrà escollir opacitat, brillantor i contrast de l’aspecte 

del MDT i a més un grup d’opcions d’aspecte predefinits.  

Els paràmetres escollits per generar un relleu millorat del terreny han estat: 

Capes superposades 
DTM 15 m. Baix Llobregat Proporcionat per UOC 
Shaded Result Layer (MDT) Generada en la inserció 

Paràmetre Legend 
-3,30 a 5 metre Seqüència de color blau 

5 metre a 400 metres Tonalitats de color verd clar 
400 a 800 metres Tonalitats de color verd fosc 
800 a 1200 metres Tonalitats de color groc 

Paràmetre Settings 
Opacitat 51% 
Brillantor -15 
Contrast -2 

Blending Mode Burn 
   Taula 11 Paràmetres de Visualització del relleu millorat 

Amb les combinacions dels diferents paràmetres s’obté una nova capa anomenada Relleu Millorat que 

inserim en el nostre SIG. 

 
                                               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Fig. 43 aspecte millorat del MDT 
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2.7.3 Càlcul de la xarxa de drenatge 

Per calcular la xarxa de drenatge del riu Llobregat en la zona d’estudi el punt de partida serà la capa 

proporcionada DTM 15 m. El primer pas serà omplir les depressions per treure els punts més baixos de 

la capa. Una depressió anòmala pot afectar al model de direccions de corrents que aplicarem 

posteriorment 

 

 

 

 

 

 

 

 

 

Fig.44 Quadre de diàleg Fill depressions    Fig.45 Resultat obtingut 

Es fa Grid ->Surface ->Fill Depressions. Per editar el resultat Grid -> Edit Window Es crea una 

superfície més suau que serà més fàcil modelar.  

Es crea a continuació el flux de direccions de corrents amb l’opció Grid -> Surface -> Downhill Path 

 

 

 

 
 
 
 
 
 
 
 

 Fig.46 Quadre de diàleg Flow directions                                    Fig.47 Resultat Obtingut 
 
S’obté una superfície on en funció de la inclinació del terreny cap una direcció ens assenyala, 

mitjançant una fletxa quina serà la direcció del flux dels corrents d’aigua. Si ampliem la imatge a 1:16 

podem observar cel·la per cel·la la direcció del corrent. 
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Fig. 48 Direcció del corrent en cada cel·la                        Fig. 49 Relleu millorat direccions de corrent 
 
També és possible millorar l’aspecte per afavorir la visualització canviant els colors dels valors 0 a 128 

que ens indiquen les direccions de la rosa dels vents. 

El pas següent serà crear les acumulacions de corrent amb l’opció Grid -> Surface -> Downhill 

Accumulation. Es mostren les direccions dels corrents d’aigua en els pendents de les diferents alçades. 

Una acumulació de corrents en un punt determinat pot indicar un problema potencial. 

 
Fig.50: Quadre de diàleg Downhill accumulation                                     Fig.51: Resultat obtingut 
 
Una acumulació de corrents pot utilitzar-se per determinar quan un corrent comença a ser d’una 

determinada envergadura. S’utilitza l’eina de recerca de 

valors raster  per verificar el valor de la cel·la a la 

capçalera dels torrents i s’identifica que la cel·la pren 

un valor proper a 915. Tindrem  en     compte   que   els 

valors   propers a 0 representen alçades    topogràfiques 

màximes i els valors més alts són indicatius de fluxos 

de corrent més cabalosos. 

Per calcular ara la xarxa de drenatge es selecciona Grid 

-> Classification ->Recode , on s’obté una capa on tots 

els corrents de la xarxa de drenatge tenen valor 1 i les 
                    Fig.52 Xarxa de Drenatge  
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altres prenen el valor void. Es pot segmentar la xarxa de drenatge trobada per determinar les zones 

d’influència de cada corrent. Això ho podem fer seleccionant Grid ->Path -> Segmentation. S’utilitza 

la xarxa de drenatge com a font i el fitxer de Direccions del corrent creat prèviament. S’obté una xarxa 

segmentada que podrem agrupar segons les necessitats en funció dels colors de la llegenda. 

 

 

 

 

 

 

 

 

 

Per comprendre millor la utilitat d’aquesta eina es calculen quins serien els vessants d’aigua a la zona 

de Molins de Rei definint les possibles zones d’afectació dels torrents. Primer de tot identifico en la 

Xarxa segmentada quins són els segments corresponents a la zona d’estudi amb l’eina de recerca de 

valors raster.  

Trobo que els segments de la zona d’estudi 

prenen els valors 1864, 1865, 1875, 1897, 

1909, 1919, 1921, 1926, 1932, 1937, 1943, 

1955 i 2001. Utilitzo l’opció Grid -> 

Surface -> Sub-Basin Delineation i assigno 

un color diferenciat als segments definits 

amb anterioritat, obtenint les zones de 

vessants d’aigua. 

 

 

 

 

 

 
 
 
 
 
 
 

Fig. 55. Vessants d’aigua a la zona de Molis de Rei 

Fig. 56 Vessants d’aigua a la zona de Molins de rei Incorporades al SIG 

Fig. 53 Quadre de diàleg Xarxa Segmentada Fig. 54 Xarxa de drenatge segmentada 
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Fig.57 SIG complert Amb les capes estudiades 

 
2.7.4 Construcció de vistes 3D amb Geomedia i Grid 
 
Per construir el model 3D ens basem  en les capes generades pels programes Grid i Geomedia. Per una 

banda es carrega la capa de jaciments per situar-los en el 

model 3D i per l’altra es carrega els models del terreny 

amb el relleu millorat per afavorir la visibilitat. 

Seleccionem Grid -> Visualization -> Construct  3D 

Model, obtenint el següent quadre de diàleg de la figura 

58. 

Aquí es seleccionen els arxius que es vulguin visualitzar 

en el model 3D. Al quadre Source vectors es seleccionen 

les dades de tipus vectorial. Amb el botó Configure 

podem introduir les opcions que s’activaran respecte del 

vector punt Punts Jaciments. En aquesta vista 3D es 

substitueixen els punts per símbols 2D i s’incorpora 

l’atribut Jaciment. per identificar-lo en el model 3D. 

forma que quan assenyalem el punt corresponent la vista 

3D ens informa del Nom del jaciment. 

També s’indiquen quines volem que siguin les imatges  i   

superfícies que volem utilitzar en el model. 

 Per últim donem nom al model i premem OK 

Fig.58 Quadre de diàleg Model 3D 
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Per obtenir la imatge s’ha de jugar amb el control situat a la dreta de la pantalla i que serveix per definir 

la forma de la vista 3D. A la següents pantalla s’observa una vista del model amb els punts dels 

jaciments incorporats i editant les imatges amb l’opció fly around que dóna una visió de moviment de  

 

 

 

 

 

 

 

 

 

 

 

Amb les opcions que ens dóna el visor podrem definir la zona on realitzar les vistes obtenint  una 

perspectiva aèria. En les dues vistes de la pàgina tenim una vista des de la desembocadura del Llobregat 

i una altre des de la zona de Molins de Rei.  

 

 

 

 

Fig.59 Vista 3D desembocadura Llobregat 

Fig. 60 Vista 3D Zona Molins de Rei amb punts de jaciments opció fly around  
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Fig.61 Vista 3D completa de la vall del Llobregat fins la desembocadura 



El riu Llobregat i la seva relació amb el territori a l’època romana 

 Antoni Laut Barberán                                                                                                                                                                                       
                                                                                                                                                                                                       
                                                                                                                                                                                                        54 

3 La ubicació dels jaciments respecte al traçat del riu 
 
A l’època estudiada el transport per via marítima o fluvial havia de condicionar per força la situació 

dels assentaments de la població tal com hem pogut comprovar en la distribució dels jaciments al nostre 

SIG. En el moment de decidir el lloc on crear la vila o establiment de caràcter rural s’havia de valorar la 

facilitat d’accés per una via navegable degut a la pobre existència de camins per terra. D’altra banda la 

connexió de la desembocadura d’un riu amb una infraestructura portuària organitzada garantia 

l’abastiment d’un intercanvi comercial amb altres àrees de la península o bé l’exportació de productes 

preuats, com el vi d’Hispània, cap a la metròpoli romana. 

En el cas de la zona d’estudi, el port de les Sorres, jaciment amb restes de naus i que s’estenia al llarg 

de l’actual estuari del Llobregat, servia d’entrada a una zona rica en assentaments. La interrelació de la 

zona del port, un riu navegable i una via terrestre de gran importància a la zona de Martorell (Via 

Augusta) va generar tota una xarxa de poblats de diferents dimensions amb un element comú: El 

Rubrigatum com a eix de vertebració de la societat. 

Els canvis experimentats per la línia de la costa  des de l’època romana han estat molt significatius. 

Podríem situar la zona costanera en els límits de les poblacions de Gavà i Viladecans, la zona de les 

termes de sant Boi i Santa Eulàlia de Provençana, segons hem justificat en el nostre SIG. Des d’aquesta 

zona on ancoraven naus de calat suficient pel transport marítim es genera un trànsit de mercaderies cap 

a l’interior del baix Llobregat. L’existència de sitges per emmagatzemament de gra, com La Roca a 

Gavà , La Torrassa o Sant Vicenç dels Horts corrobora l’existència d’una zona d’intercanvi entre 

l’interior i altres zones de la Mediterrània.  

Altres jaciments distribuïts al llarg de la llera del riu, com els forns, són indicatius de l’activitat de 

fabricació d’embolcalls per transport de líquids com el vi. Aquestes construccions es situen a prop de la 

via de transport fluvial amb l’objectiu d’afavorir el trànsit comercial. Les pedreres podrien implicar el 

transport per mar dels blocs destinats a la construcció de les ciutats.[28] 

Els embarcadors a les zones de Molins de Rei i Sant Vicenç dels Horts en una zona estratigràfica més 

baixa ens indica que el pendent del riu era inferior a l’actual, circumstància que devia facilitar 

enormement la navegabilitat en l’època. 

L’existència d’aquestes infraestructures portuàries i la facilitat de comunicació cap a l’interior, així com 

un lloc d’ancoratge on esperar vents favorables, van influir de forma determinant en la disposició del 

poblament, tant al llarg de la costa fins a Barcino com en la distribució dels assentaments al llarg del riu 

Llobregat. 

Amb la vista aèria i georeferenciada dels jaciments esmentats, obtinguda mitjançant les eines del SIG, 

queda determinada la forta interacció entre el territori el nostre riu vermell. 
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4 Conclusions del TFC 
 
Una vegada implementats tots els punts de la memòria analitzem  l’execució del Treball de Final de 

Carrera sota tres punts de vista: primer es fa una autoavaluació del treball en relació a la planificació 

efectuada, en segon lloc determinem les conclusions definitives de les tasques efectuades i finalment 

s’estableixen unes línies futures de cara a l’aplicació de la tecnologia estudiada. 

 

4.1 Autoavaluació del pla de treball  

La primera fita referida a l’elaboració del pla de treball, es va assolir de forma correcta en termini i 

contingut, encara que el desconeixement de la dificultat dels coneixements a assolir va suposar un 

excés d’optimisme en les previsions. 

La segona fita, feia referència a elements eminentment teòrics i de descripció del funcionament del 

programari, però que han resultat imprescindibles per la realització de la part pràctica. Conceptes com 

dàtum o sistemes de coordenades han estat aplicats àmpliament en la construcció del SIG. La 

introducció d’una nova terminologia que no està relacionada necessàriament amb el mon informàtic ha 

requerit d’un esforç en la recerca de conceptes i en la comprensió dels components bàsics de ciències 

com la cartografia i la topologia. La fita es va assolir amb un cert retard sobre la data prevista en el pla 

de treball degut a la gran quantitat de conceptes sistematitzats. 

Ha estat en la tercera fita, essencialment relacionada amb la part pràctica, on ha estat necessari exhaurir 

tots els dies establerts a la planificació per la seva consecució degut principalment a la càrrega de 

treball que suposa la introducció a un programari nou i amb el que ha estat necessari familiaritzar-se de 

forma intensiva per poder assolir d’una forma adient els objectius del Treball de Final de Carrera. 

 

4.2 Conclusions del Treball de Final de Carrera  

Personalment, crec haver assolit tots el els objectius determinats en el punt 5.1.2. De forma general s’ha 

aprés a plantejar un projecte SIG i utilitzar les principals eines que es proporcionen per a la resolució 

d’un problema concret, arqueològic en aquest cas, i que demostra la gran flexibilitat de funcionament 

d’aquest tipus de programari. S’ha relacionat el SIG amb una Base de Dades (Access en aquest cas) i 

s’ha treballat sobre aquesta base de dades incorporant elements de caràcter toponímic. S’han aprés els 

principals conceptes de Cartografia i Topologia, necessaris per a la construcció d’un SIG. S’han 

introduït conceptes d’anàlisi vectorial i raster, imprescindible per entendre el sistema de capes.  

En quant als objectius específics, el treball amb el programari de Geomedia ha suposat una assimilació 

ràpida de múltiples conceptes nous i que han provocat una certa dificultat en la realització de 

determinades tasques. Tanmateix el fet d’haver de modificar la programació per no disposar del mòdul 

Terrain i que inicialment va generar un cert desconcert, ha suposat la profundització del treball amb el 

mòdul Grid afegint conceptes molt interessants aplicats a l’anàlisi de conques hidrogràfiques.  
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Un dels aspectes realment engrescador del mòdul Grid ha estat l’anàlisi del Mòdul Digital del Terreny 

(MDT) i la generació de vistes 3D amb la informació prèviament generada a Geomedia i amb el qual es 

pot apreciar una visió del terreny molt apropada a la realitat. 

 

4.3 Línies futures 

La introducció dels SIG, aplicats a una problemàtica concreta suposarà que en un termini curt de temps 

aquesta tecnologia s’estengui a molts àmbits: 

� Traçat de rutes no cartografiades. 

� Traçat de xarxes públiques de gas, línies elèctriques, fibra òptica, ferrocarril. 

� Inventari i situació d’instal·lacions de tot tipus. 

� Simulació de models del terreny. 

� Estudi de zones d’influència. 

Amb tota probabilitat l’expansió de SIG de caràcter lliure i gratuït com gvSIG, farà que aquests 

sistemes s’implantin definitivament. 

La incorporació de mòduls amb eines 3D suposarà que els SIG  treballin amb elements que ajudaran a 

construir models que cada vegada s’acostaran més a la realitat. 
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